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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Control+clic ou clic droit 
selon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

Ctrl+Q ⌘+Q Quitter LibreOffice

F11 ⌘+T Ouvre l’onglet Styles du volet latéral

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Introduction

Ce chapitre couvre les méthodes de partage et de révision collaboratives des classeurs : édition si-
multanée, enregistrement des modifications, ajout de commentaires, révision des modifications, fu-
sion et comparaison de documents, enregistrement et utilisation des versions d’un document.

Partager des documents (collaboration)

Partager un classeur permet à plusieurs utilisateurs d’ouvrir en même temps le même fichier pour 
le modifier. Ce classeur doit se trouver sur un disque partagé, un serveur, un site web ou quelque 
chose d’équivalent. Certaines conditions doivent être réunies concernant la gestion des permis-
sions des utilisateurs par les systèmes d’exploitation :

• le fichier partagé doit être situé à un emplacement accessible à tous les collaborateurs ;

• les permissions du fichier du document et celles du fichier verrou correspondant doivent être 
paramétrées de telle manière que tous les collaborateurs puissent créer, effacer et modifier 
les fichiers.

Consultez la documentation de votre système d’exploitation pour plus de détails sur la façon de 
définir les permissions des fichiers. Voyez aussi « Ouvrir et enregistrer des fichiers sur des ser-
veurs distants » dans le chapitre 1, Présentation de LibreOffice du Guide du débutant.

Conseil

Chaque collaborateur doit au minimum saisir son nom dans la page LibreOffice – Données 
d’identité de la boîte de dialogue Options (Outils > Options > LibreOffice > Données 
d’identité dans la barre de menu).

Paramétrer un classeur pour le partage

Figure 1 : Choisir de partager un classeur.
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À tout moment, vous pouvez paramétrer un classeur pour le partager avec d’autres utilisateurs. 
Une fois le classeur ouvert, choisissez Outils > Partager le classeur pour activer les fonctionnali-
tés de collaboration pour ce document.

Pour activer le partage, cochez la case en haut de la boîte de dialogue, puis cliquez sur OK. Si le 
classeur a été enregistré auparavant, un message apparaît vous indiquant que vous devez enre-
gistrer le document afin d’activer le mode partagé. Cliquez sur Oui pour continuer. Sinon, la boîte 
de dialogue d’enregistrement s’ouvre. Après enregistrement, la mention (partagé) est alors affichée
dans la barre de titre, à la suite du nom du fichier.

La commande Outils > Partager le classeur peut être utilisée pour basculer un document du 
mode partagé au mode non partagé. Cela signifie que les autres utilisateurs ne pourront plus le 
modifier. Il peut être préférable d’enregistrer une copie du classeur partagé sous un autre nom ou 
à un autre emplacement, puis de basculer cette copie en mode non partagé.

Ouvrir un classeur partagé

Lorsque vous ouvrez un classeur qui est en mode partagé, un message apparaît vous indiquant 
que le document est en mode partagé et que certaines fonctionnalités ne sont pas disponibles 
dans ce mode. Cliquez sur OK, et le document est ouvert en mode partagé.

Les fonctions suivantes ne sont pas disponibles dans un classeur partagé :

Édition > Suivi des modifications, sauf Fusionner le document

Insertion > Média > Vidéo ou son
Insertion > Commentaire
Insertion > Objet
Insertion > Diagramme
Insertion > Plage ou expression nommée
Insertion > Table dynamique
Insertion > Cadre flottant
Insertion > Fontwork
Insertion > Ligne de signature

Format > Fusionner les cellules
Format > Zones d’impression

Feuille > Déplacer/copier la feuille
Feuille > Supprimer des feuilles
Feuille > Insérer une feuille à partir d’un fichier
Feuille > Plage ou expression nommée
Feuille > Renommer la feuille
Feuille > Couleur de l’onglet

Données > Définir la plage
Données > Trier
Données > Tri croissant
Données > Tri décroissant
Données > Sous-totaux
Données > Validité
Données > Opérations multiples
Données > Consolider
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Données > Plan et groupe
Données > Table dynamique

Outils > Protéger la feuille
Outils > Protéger la structure de la feuille de calcul

Enregistrer un classeur partagé

Quand vous enregistrez un classeur partagé, une des situations suivantes peut se produire :

• Si le document n’a pas été modifié et enregistré par un autre utilisateur depuis que vous 
l’avez ouvert, le document sera enregistré.

• Si le document a été modifié et enregistré par un autre utilisateur depuis que vous l’avez ou-
vert, l’un des événements suivants va se produire :

– Si les changements ne sont pas en conflit, le document est enregistré. Un message appa-
raît, vous indiquant que votre classeur a été mis à jour et enregistré par d’autres utilisa-
teurs, et toutes les cellules modifiées par l’autre utilisateur apparaissent avec une bordure
rouge.

– Si les changements sont en conflit, la boîte de dialogue Résoudre les conflits s’ouvre. 
Vous devez décider pour chaque conflit quelle version conserver, la vôtre ou celle de 
l’autre personne. Lorsque tous les conflits sont résolus, le document est enregistré. Pen-
dant que vous résolvez les conflits, aucun autre utilisateur ne peut enregistrer le docu-
ment partagé.

• Si un autre utilisateur essaie d’enregistrer le document partagé et de résoudre les conflits, un
message apparaît vous indiquant que le fichier classeur partagé est verrouillé à cause d’une 
fusion en cours. Vous pouvez alors renoncer à la commande Enregistrer pour le moment, et
réessayer plus tard.

Une fois que vous avez enregistré avec succès un document partagé, le document affiche la toute 
dernière version de tous les changements enregistrés par tous les utilisateurs.

Réviser des documents

Vous pouvez utiliser plusieurs méthodes pour réviser, modifier et commenter un classeur.

• Vous pouvez utiliser les marques de modifications pour montrer les ajouts, les suppressions 
et les changements de formats. Plus tard, vous (ou un autre utilisateur) pourrez réviser le do-
cument et accepter ou rejeter chaque modification.

• Si vous n’utilisez pas le partage de fichier, vous pouvez effectuer les modifications dans une 
copie du document (enregistré dans un dossier différent, avec un nom différent, ou les deux),
puis utiliser Calc pour comparer les fichiers et mettre en évidence les changements. Voir 
« Comparer des documents » page 11.

• Vous pouvez enregistrer des versions qui seront conservées dans le fichier original. Voir 
« Enregistrer des versions » page 12.

Les relecteurs peuvent laisser des commentaires dans le document, attachés à des modifications 
particulières ou autonomes.
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Remarque

Ces outils sont identiques à ceux utilisés dans Writer pour le suivi des modifications.

Préparer un document pour la révision (facultatif)

Quand vous envoyez un document à un autre utilisateur pour révision ou édition, vous pouvez tout 
d’abord vouloir le protéger afin que l’éditeur ou le relecteur n’ait pas à se souvenir de bien activer 
les marques de modifications.

Une fois les marques de révision activées, vous pouvez protéger le document par un mot de passe
que tout utilisateur devra saisir pour désactiver la protection et accepter/rejeter les modifications.

 1) Ouvrez le classeur et sélectionnez Édition > Suivi des modifications > Enregistrement 
dans la barre de menu. Une coche apparaît devant cette option pour indiquer que l’enregis-
trement est actif. Vous pouvez aussi utiliser Fichier > Propriétés et cocher Enregistrer les 
modifications dans l’onglet Sécurité.

 2) (Faculatif) Cliquez sur Édition > Suivi des modifications > Protéger. Dans la boîte de dia-
logue Protéger l’historique, saisissez un mot de passe, confirmez-le et cliquez sur OK. Vous 
pouvez aussi cliquer sur le bouton Protéger dans l’onglet Sécurité de la boîte de dialogue 
Propriétés pour ouvrir la boîte de dialogue Saisir le mot de passe.

Enregistrer les modifications

Pour enregistrer les modifications, ouvrez le classeur et vérifiez qu’il y a une coche, ou un fond 
bleu autour de l’icône selon votre système d’exploitation, devant l’élément Édition > Suivi des 
modifications > Enregistrement pour indiquer que cette fonction est active.

! Attention

Désactiver l’enregistrement des modifications après avoir effectué des changements met fin 
à cet enregistrement. Toute information concernant les modifications est alors perdue. Une 
boîte de message vous en prévient si vous essayez de le faire.

La suite de ce chapitre va être illustrée par l’exemple de l’élaboration d’un budget pour une équipe 
de football.

Mettez-vous dans la situation d’un président d’un club de football. L’entraîneur d’une équipe de 
jeunes vous a soumis un budget pour la saison, et vous avez besoin de le modifier et de lui retour-
ner la nouvelle version.

Vous vous inquiétez du fait que, si vous faites simplement des modifications, l’entraîneur ne verra 
donc pas les changements que vous avez effectués. Vous décidez alors d’utiliser et d’activer la 
fonctionnalité d’enregistrement des modifications, pour que l’entraîneur puisse voir facilement les 
changements que vous avez effectués.

La Figure 2 montre le classeur du budget que l’entraîneur vous a soumis.

En examinant les chiffres, vous voyez que vous pourriez économiser sur certains postes :

• les collations d’après-match peuvent être apportées par les parents ;

• les nouveaux maillots peuvent attendre : en acheter seulement 5 pour remplacer ceux qui 
sont usés ;
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• acheter des ballons d’entraînement moins chers ;

• acheter seulement 2 protège-tibias de rechange ;

Figure 2 : Classeur du budget de l’équipe de football.

Pour effectuer ces modifications, utilisez l’enregistrement des modifications de Calc. Pour com-
mencer cet enregistrement :

 1) Ouvrez le classeur contenant le budget.

 2) Sélectionnez Édition > Suivi des modifications > Enregistrement dans la barre de menu.

 3) Commencez à modifier le document.

Une bordure colorée, avec un point dans son coin supérieur gauche (comportement par défaut), 
apparaît autour de la cellule où une modification a été effectuée (Figure 3). Les autres utilisateurs 
peuvent alors facilement savoir quelles cellules ont été modifiées. Une ligne ou une colonne sup-
primée est marquée par une barre colorée épaisse.

Figure 3 : Classeur édité où les cellules modifiées sont bordées de rouge.

Pour voir ce qui a été modifié dans une cellule, survolez-la avec le pointeur de la souris comme sur
la Figure 4.

Figure 4 : Voir les détails d’une modification.

Réviser des documents | 5



Remarque

Certaines modifications, comme le formatage d’une cellule par exemple, ne sont ni enregis-
trées ni signalées.

Astuce

Pour modifier la couleur qui signale les modifications, sélectionnez Outils > Options > 
LibreOffice Calc > Modifications. Par défaut, une couleur différente sera attribuée à 
chaque relecteur (s’il a pris soin de renseigner son nom comme indiqué dans « Partager 
des documents (collaboration) » page 1).

Une fois que vous avez terminé vos modifications dans le document, vous pouvez l’envoyer à 
votre entraîneur.

Vous aurez peut-être envie d’expliquer le raisonnement qui a guidé les modifications que vous 
avez effectuées. Vous pouvez exprimer votre point de vue de deux manières : en ajoutant des 
commentaires aux changements que vous avez effectués, ou en ajoutant des commentaires glo-
baux au classeur.

Ajouter des commentaires aux modifications

Calc ajoute automatiquement à toute modification enregistrée un commentaire qui précise ce qui a
été modifié (par exemple, Cellule B3 modifiée de '15' en '5'). Les relecteurs et les auteurs peuvent 
ajouter leurs propres commentaires pour expliquer les raisons de leurs modifications.

Pour ajouter un commentaire à une modification :

 1) Faites la modification dans le classeur.

 2) Sélectionnez la cellule où la modification a été effectuée.

 3) Choisissez Édition > Suivi des modifications > Commentaires. La boîte de dialogue de la
Figure 5 s’ouvre. Le commentaire ajouté automatiquement par Calc ne peut pas être modifié.

 4) Saisissez votre propre commentaire et cliquez sur OK.

Figure 5 : Saisie d’un commentaire associé à une modification.
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Remarque

N’utilisez pas l’entrée Insertion > Commentaire de la barre de menu ou Insérer un com-
mentaire du menu contextuel dans ce cas. Les commentaires insérés par ces méthodes 
sont gérés de façon différente et n’apparaissent pas dans la boîte de dialogue Gérer les mo-
difications.

Une fois que vous avez ajouté un commentaire à une cellule modifiée, vous pouvez l’afficher (sous
forme d’infobulle) en plaçant le pointeur de la souris au-dessus de la cellule, comme Figure 6 :

Figure 6 : Commentaire ajouté à la cellule B3.

Le commentaire s’affiche également dans la boîte de dialogue où vous acceptez ou refusez les 
modifications, comme illustré sur la première ligne de la Figure 10 page 10.

Éditer les commentaires des modifications

 1) Sélectionnez la cellule dont vous voulez modifier le commentaire.

 2) Choisissez Édition > Suivi des modifications > Commentaires dans la barre de menu. La 
boîte de dialogue de la Figure 5 s’ouvre.

 3) Modifiez le commentaire et cliquez sur OK.

Le commentaire ajouté automatiquement par Calc ne peut pas être modifié.

Vous pouvez parcourir les commentaires grâce aux flèches situées en bas de la boîte de dialogue.

Ajouter d’autres commentaires (commentaires généraux)

Calc dispose également d’un autre type de commentaires (appelés « notes » dans les anciennes 
versions de LibreOffice), que les auteurs et les relecteurs utilisent souvent pour échanger des 
idées, formuler des suggestions et réfléchir collectivement dans un document.

Pour ajouter un commentaire général :

 1) Sélectionnez la cellule à laquelle le commentaire va s’appliquer.

 2) Sélectionnez Insertion > Commentaire dans la barre de menu ou faites un clic droit et choi-
sissez Insérer un commentaire. Une zone de saisie apparaît, comme Figure 7.

Figure 7 : Insertion d’un commentaire général.

 3) Saisissez le texte de votre commentaire dans cette zone.
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 4) Cliquez en dehors de la zone pour la fermer.

La cellule à laquelle vous avez ajouté un commentaire comporte désormais un point coloré dans le
coin supérieur droit, comme illustré Figure 8. Elle n’a pas de bordure colorée, à moins que la cel-
lule ait été également modifiée.

Figure 8 : Point coloré dans une cellule qui comporte un commentaire.

Remarque

Si le point coloré n’apparaît pas pour signaler une cellule dans laquelle se trouve un com-
mentaire, vérifiez, dans Outils > Options > LibreOffice Calc > Affichage, si l’option Indica-
teur de commentaire est bien cochée.

Astuce

Vous pouvez modifier la couleur d’arrière-plan par défaut des commentaires dans Outils > 
Options > LibreOffice > Couleurs de l’interface dans Arrière-plan des commentaires.

Pour afficher le commentaire que vous venez d’ajouter, placez le pointeur de la souris au-dessus 
de la cellule correspondante ; le commentaire apparaît, comme ci-dessous.

Figure 9 : Affichage d’un commentaire.

Modifier des commentaires généraux

Vous pouvez modifier et formater le texte d’un commentaire, comme vous le feriez pour tout autre 
texte.

 1) Faites un clic droit dans la cellule contenant l’indicateur de commentaire et choisissez Éditer
le commentaire dans le menu contextuel.

 2) Calc affiche le commentaire de la cellule. Le curseur change d’aspect pour prendre sa forme 
habituelle qui marque l’entrée de texte en clignotant, et la barre d’outils Formatage qui était 
indisponible devient active et affiche les attributs du texte.

 3) Une fois la modification effectuée, cliquez à l’extérieur du commentaire pour le désélection-
ner.

Formater les commentaires généraux

Vous pouvez changer la couleur d’arrière-plan, le style de bordure, la transparence et d’autres at-
tributs d’un commentaire.
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 1) Faites un clic droit dans la cellule contenant l’indicateur de commentaire et choisissez Affi-
cher le commentaire dans le menu contextuel.

 2) Cliquez dans le commentaire lui-même. La barre d’outils Formatage change pour afficher la 
plupart des options de formatage des commentaires. Ce sont les mêmes que les options 
pour formater les éléments graphiques ; voir le chapitre 5, Utiliser des éléments graphiques, 
pour plus d’informations.

Vous pouvez également faire un clic droit sur le commentaire pour afficher un menu d’op-
tions, certaines menant à des boîtes de dialogue vous permettant de paramétrer finement le 
formatage ; ces boîtes de dialogue sont également décrites dans le Chapitre 5.

 3) Une fois la modification effectuée, cliquez à l’extérieur du commentaire pour le désélection-
ner. Pour masquer à nouveau le commentaire, faites un clic droit dans la cellule et cliquez 
sur Masquer le commentaire dans le menu contextuel.

Rechercher les commentaires généraux

Les petits indicateurs de commentaire dans le coin des cellules peuvent être difficiles à distinguer. 
Par conséquent, Calc propose deux autres façons de les repérer, en affichant tous les commen-
taires et en utilisant le navigateur. Pour afficher tous les commentaires généraux, sélectionnez Af-
fichage > Commentaires dans la barre de menu. Pour les masquer, sélectionnez de nouveau 
cette entrée de menu.

S’il existe des commentaires dans un classeur, le navigateur affiche un symbole (habituellement le 
signe + ou une flèche) devant le mot Commentaires. Cliquez sur celui-ci pour afficher la liste des 
commentaires. Faites un double-clic sur le commentaire voulu pour aller directement dans la cel-
lule associée.

Remarque

La fonction Affichage > Commentaires et le navigateur montrent les commentaires géné-
raux mais pas ceux associés au suivi des modifications.

Accepter ou rejeter les modifications

Lorsqu’un document vous est retourné avec des modifications, tout l’intérêt de l’enregistrement 
des modifications devient évident. Vous pouvez alors, en tant qu’auteur initial du document, par-
courir les modifications effectuées et décider de leur sort. Pour commencer ce processus :

 1) Ouvrez le document modifié.

 2) Sélectionnez Édition > Suivi des modifications > Gérer. La boîte de dialogue de la Figure 
10 s’ouvre.

 3) Vous pouvez examiner individuellement chaque modification puis l’accepter ou la rejeter au 
fur et à mesure. Vous pouvez aussi accepter ou rejeter la totalité des modifications.

La colonne Commentaire contient l’explication par défaut de la modification effectuée. Si le relec-
teur a ajouté un commentaire à sa modification, il est affiché avant l’explication par défaut, comme 
sur la première ligne de la Figure 10.

Réviser des documents | 9



Figure 10 : La boîte de dialogue Gérer les modifications.

Si plus d’un utilisateur a révisé le document, un relecteur a pu rectifier une modification d’un autre 
relecteur. Dans ce cas, les modifications sont structurées hiérarchiquement avec un signe + qui 
permet d’ouvrir l’arborescence. Les modifications déjà acceptées ou refusées sont également re-
groupées.

Figure 11 : Les filtres définis ici limitent les modifications affichées dans l’onglet Liste.

L’onglet Filtrer (Figure 11) vous permet de filtrer la liste des modifications par date, auteur, plage 
de cellule ou termes spécifiques dans les commentaires. Après avoir spécifié les critères de filtre, 
revenez à l’onglet Liste pour voir le résultat. Le filtrage n’affecte que le contenu de l’onglet Liste de 
la boîte de dialogue, vous ne verrez aucun changement dans votre classeur.
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Fusionner les documents

Les méthodes décrites jusqu’ici sont efficaces si vous n’avez qu’un relecteur à la fois. Parfois, ce-
pendant, plusieurs relecteurs renvoient toutes les versions modifiées d’un document en même 
temps. Dans ce cas, il est plus rapide et efficace de réviser toutes ces modifications en une seule 
fois, plutôt que de le faire individuellement pour chaque version. Pour ceci, vous pouvez fusionner 
les documents dans Calc.

Pour fusionner des documents, la fonction d’enregistrement des modifications doit être active pour 
chacun d’entre eux.

 1) Ouvrez le document d’origine.

 2) Sélectionnez Édition > Suivi des modifications > Fusionner le document.

 3) Une boîte de dialogue de sélection de fichiers s’ouvre. Sélectionnez le fichier que vous vou-
lez fusionner et cliquez sur Ouvrir.

 4) Une fois la fusion des documents effectuée, la boîte de dialogue Gérer les modifications 
s’ouvre, comme dans la Figure 10, et affiche les modifications de plusieurs relecteurs. Si 
vous voulez fusionner plus de documents, fermez la boîte de dialogue et répétez les 
étapes 2 et 3.

Les modifications sont alors combinées dans un seul document et vous pouvez les accepter ou les
rejeter au cours d’un même processus. Les modifications de chaque relecteur apparaissent avec 
des couleurs différentes dans le document.

Comparer des documents

Parfois, quand vous partagez des documents, les relecteurs peuvent oublier d’enregistrer leurs 
modifications. Ce problème peut être résolu par Calc, qui peut retrouver ces modifications en com-
parant des documents.

Pour comparer des documents, vous devez disposer du document original et de celui qui a été 
modifié. Pour les comparer :

 1) Ouvrez le document modifié que vous voulez comparer au document original.

 2) Sélectionner Édition > Suivi des modifications > Comparer le document.

 3) Une boîte de dialogue de sélection de fichiers s’ouvre. Sélectionnez le document original et 
cliquez sur Ouvrir.

! Attention

Veillez à bien ouvrir le document modifié en premier et non le document original.

Calc détecte et repère les modifications de la façon suivante :

• Toutes les données qui se trouvent dans le document modifié mais pas dans le document 
original sont repérées comme insérées.

• Toutes les données qui se trouvent dans le document original mais pas dans le document 
modifié sont repérées comme supprimées.

• Toutes les données modifiées sont repérées comme modifiées.
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À partir de ce point, vous pouvez parcourir ces repères et accepter ou rejeter les modifications.

Enregistrer des versions

La plupart des documents passent par plusieurs versions. Il est souvent utile d’enregistrer les nou-
velles versions d’un document. Vous pouvez le faire en enregistrant une copie du document (sous 
un nom différent) après chaque révision, ou en utilisant la fonctionnalité de gestion des versions de
Calc.

! Attention

Si vous utilisez la commande Fichier > Enregistrer sous pour un document qui comporte 
plusieurs versions, ces anciennes versions ne seront pas enregistrées dans le nouveau fi-
chier.

Pour utiliser la gestion des versions de Calc :

 1) Choisissez Fichier > Versions dans la barre de menu. La boîte de dialogue de gestion des 
versions s’ouvre.

Figure 12 : La boîte de dialogue de gestion des versions.

 2) Cliquez sur le bouton Enregistrer une nouvelle version pour enregistrer une nouvelle ver-
sion.

Figure 13 : La boîte de dialogue Insérer un commentaire de version.
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 3) Une boîte de dialogue s’ouvre, où vous pouvez saisir un commentaire sur cette version (Fi-
gure 13).

 4) Après avoir saisi votre commentaire et cliqué sur OK, la nouvelle version est ajoutée dans la 
liste des versions existantes. (Figure 14).

Figure 14 : Liste des versions mises à jour.

Remarque

Le nouveau fichier a une taille supérieure, comme si deux classeurs étaient enregistrés en-
semble.

Une fois le fichier enregistré, les deux versions y sont présentes. Vous pouvez alors :

• ouvrir une ancienne version : sélectionnez la version et cliquez sur le bouton Ouvrir ; une 
copie en lecture seule de l’ancienne version s’ouvre ;

• comparer toutes les versions : cliquez sur le bouton Comparer et une action similaire à la fu-
sion de documents s’effectue. Une boîte de dialogue Gérer les modifications s’ouvre et liste 
toutes les modifications à travers les différentes versions ;

• modifier le commentaire : sélectionnez une version et cliquez sur le bouton Afficher pour af-
ficher le commentaire saisi par vous ou d’autres relecteurs ;

• supprimer une version : sélectionnez la version et cliquez sur le bouton Supprimer.
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